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1. Some Photoshop Basics
a. Menus:

When Photoshop Opens, you see your basic toolbox on the left and the option bar
that provides the options for the highlighted tool is also usually visible across the top.
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Options bar

When you double click on a tool from the tool bar, its
option bar appears. There are many more options on
your top menu bar. The Window Menu allows you to
hide or show other palettes at your convenience. These
moveable palettes can be closed at anytime and contain
a range of options. One palette you might want to
always keep open is the layers palette.

b. Starting a new document. F— =
There is no canvas showing unless you create one. To imogesizedom
create your canvas, go to the File menu and select new. J |

You can input your width and height and select from ;
Inches, pixels, cm, etc. If you are planning to display
your work on the web, it’s a good idea to limit your
width to @600 pixels. If you work is going to viewed on
a computer screen, you will want to select a resolution
of 75 on a Mac and 96 on a Windows machine. Higher
resolutions are only for printed materials.

Select RGB monitor for viewing on the web.




2. Working with Type in 6.0
Photoshop 6.0 has many new Type features. The foremost being that it uses vector rather
than pixilated type. Vectors have crisp defined edges with sharper output that lets you
edit and manipulate your text in new ways. There are also differences in where the text
menu appears, how you can work with editable and rasterized layers, and save unique
layer styles.

a. Some Basics of the Text Tool
When type is created in Photoshop it automatically appears on its
own layer. What’s new in version 6.0 is that you can change the
attributes, (e.g. , font, style, color) and apply different i
characteristics to text in the same layer. An editable layer lets you
transform the type, apply layer effects or change its opacity but you can’t apply fillers or
fill it unless you rasterize it (Layer Menu/Rasterisze/Type). Once it is rasterized, you can
no longer manipulate individual attributes.

All type is created using the Type tool. i ] Selecting this tool opens the type tool
option bar.
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b. To create an editable type layer:
Choose the Create a text layer tool from the top menu: Then choose your orientation
determining whether your text will be written horizontally or vertically.

Click to define an insertion point - -
and the cursor will appear on your T LI.E' [ria b T=] [Fepanr _[7]
screen. Select a font family, style,
size, and anti-aliasing method (e.g.,
crisp edges, strong edges). Anti-
aliasing smoothes the edges of
smaller type by including
transparent pixels along its edges.

Creale a lext layer

Creale a selection or mask
Honzontal orientation
=Nertical onentation

To Edit text you need to select it. You can select a single character, a ©
word, or all the characters on the same type layer. Those particular
letters or words selected, can have a new style, color, or font applied to | J
them. After performing the text editing, click on the commit changes | I
button from the top option bar. —
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If you wish to go back to a previously written text e e T ey

layer, double click on the T tool from the Layer | Layers N Channels ™, Paths s

ok

menu. You can open this from the top Window m Opacity: [io0% [
menu. You will then be able to edit your text as lon
y g Ll:u:k:'-"'L O+ On

as you have not rasterized it. Select the text you

wish to change and then the features you wish to & || Photoshop
change. You can select all of the text or just a letter. i

TIP:: For greater flexibility, place individual words or characters on separate layers so
they can be moved around independently. (Create a New layer from the Layer Menu)

C. How to move a type layer

(9
Choose the move tool from the side menu & . From the layers palette, click on the
name of the layer you want to move. Click on the type from that layer and drag the type
to its new destination.
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d. Some Special Effects:
1) To Warp Text you can use the warp button on the top Text menu bar.

[
"T" In the Warp text -, T :P’ JL—:

) o .
dialogue box, select P < ~

the kind of warp
effect.



Layer Style

Blending Cphons: Defalt

2) To Apply a Style. You can
enhance a layer by adding a
shadow, glow, bevel, emboss, or
other special effects from a
collection of automated and
editable layer styles. On the
layer palette menu, you will see
all the layers in your document.
Text layers have a T with their

B brep Shadow

[ banar Shadew

& Coster Giow

O iner Giow

B Bavel and Embare

[ Textwre
O satin
[ Coler Crvartay
B Grasent Cvertay
O Pattern Svertay

o Stroke

Strake
Stractwe

S e [
Pusibon: (Cuinge ]
Etend st Marmal =
Opacity: e=——— g |™

Fill Typa | Cobor =

e

MNew Style..
B4 Preview

-l

words to the right. Double click on the layer’s words and the Layer Style
menu will appear in the diagram below, you would double click on the U

to access the style
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menu for that layer.. !

This Photoshop graphic

was made with a Drop Shadow/
Bevel and Emboss combination
applied.

Anyone of the styles has an adjustable menu also.
Double click on the effect’s word to bring up this
menu.

After checking the box, to add a Stroke to the
text (a stroke creates a border around the text)
click on the word Stroke. By double clicking on
the word Stroke, the menu below appears. Here
you can select your border color and width and
other characteristics. If you create a unique style

that you wish to keep and apply to other text, click the New Style button on the right. .
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special style to. Open the o ot LS et
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Window menu on the top
of the page.

Select the style you wish
to apply to your text. You
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can load other style palettes by clicking on the arrow to the right of the
styles tab and indicating the selection to load.
You can create your own styles and add them to the menu.
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Double click on the name of the text layer that you wish to fill with a
pattern. Check the pattern box and double click on Pattern Overlay.
A series of patterns will appear. You can add your own patterns from
pictures or drawings.

3) To Fill text with a Pattern

Lyt St

Falisia Swesl =, .
== o
e ) L
ot i Opazhy =-‘=E = I G‘A‘r‘i‘l’;ﬂ‘i_ I

e fhaies
e - < = Prew
o W=

[ v it i
®

Ll G

I ke I wreentarge
O st ' Fattern b
[ Camer Cmmrtay L
[ o it ity | I amadl leaves
I Pt e e Ry { lﬂ
Ciwebs | | patrern 7 =}

To make your own pattern, you can select a portion of a photograph, picture, or open a
new canvas and paint a pattern.

Whatever the source, define the

area of your pattern using the

marquis tool. Then go to the Edit

area and select Define Pattern. You

will then be given a chance to name

your pattern.



4) To fill your type with a gradient.

Winda,

Double click on the name of the text layer that you wish to fill with a
pattern. Check the gradient box and double click on the Gradient bar to
create your own gradient or select from a variety of pre-set ones.
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You can also adjust the kind of gradient style: linear, radial, angle,
reflected and diamond effects are available.



After double clicking on the gradient bar the following option menu will
appear.
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to access color picker -

To create a gradient from your selected colors, double click on the icon
shown above. Your Color picker will appear allowing you to select a
color. Click the same icon on the right side of the gradient slider to change
that color.

5) To make text look almost invisible create a layer of text with
same pattern you fill in your text with. Some times it is so hard to see that
I recommend that you include a bevel and shadow effect. In this example,

The background was first filled with a pre-identified pattern. (Select paint can
then top Edit menu/fill/pattern.

Next select the text tool and type your editable layer.

After checking the box indicating you are done, double click the name of the text
layer from your layer window menu.

When your layer style menu appears, click Pattern Overlay and select the same
pattern as your background. You can they explore shadows, glows, and other
styles so that you subtly see your text.



* To get the angle, I typed Photo and Shop in separate layers and then in the Shop
layer, went to Layer/Type/warp text and selected bulge.

6) Controlling letter opacity creates some other interesting text effects:
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You can also drag the layers in the layer menu box and drop them to a higher layer for
them to appear most forward.

You can delete a layer by dragging it from the layer menu to the trash.

7) Putting text on a graphic

You can label or write on any graphic. From the file menu, select open and the graphic
you wish to write on. Your graphic will appear on the background layer. Click you T tool
and write on your background as if it were any regular background.

8) Applying Filters:
After writing and committing to your text, you can apply a number of filters to your text
to create different effects. Here are a couple of combinations I found Interesting.

Uvin

*  Write UVM using a thick font (Modern Black).
* Apply Filter/Artistic/Poster Edges
*  You will be asked to rasterize the text: Remember this means you can no longer

This type layer must be rasterized before
proceeding. Its text will ne longer be
editable. Rasterize the type?

Cancel | oK l

individualize fonts on the same layer.
Check OK

* Apply Filter/Stylize/Emboss — I also adjusted some of the emboss settings

0K I
% You can look at a preview of your text while you adjust the

settings. The + zooms you in and the — takes you out to a smaller
3 o § view of the text.
Angte: [735 ] » ® Each of the filter options lets you adjust the settings.

Height:[3___| pixels
Amount: %o 9




* Add layer style of drop shadow

9. Saving in Photoshop

Before you save in any other format, it is advisable to save your graphic as a Photoshop
File. This will protect the separate layers and allow you to edit the graphic. For work that
will appear on the web, you want to save your graphic as either a JPEG or GIF. For
printed material , use Tiff.

* JPEG or JPG Jpeg= Joint Photographic Expert Group
A jpeg is a cross-platform graphic file format. It reduces the size of a file by
removing data from the graphic image to make it smaller. It does not reduce
the number of colors.
* Limitations:
You can't make jpegs transparent.
* Advantages:
Uses a multitude of colors.
Better suited for photographs, watercolor images, pencil or charcoal drawings.
You can choose a variety of compression levels.

* GIF or JIFF Gif= Graphic Interchange Format. Gifs are another compressed
graphic file format better suited for clip art, text, and simple graphics

Gif images use indexed color which means they have a maximum of 256
colors. They compress files by removing color.
* Limitations:
They sometimes look grainy
* Advantages:
They can have one transparent color.
They can be interlaced. (Graphics appear in layers with increased
clarity when they load)
They can be animated
They are low file size and will load more quickly

For further information on whether to use a jpeg or gif, check out
http://www.widearea.co.uk/designer/

Below is a photograph saved in both formats for your comparison.
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Jpeg ' Gif
To save as a JPEG in Photoshop, select save as from the File menu.

Then select

jpeg as your format.

¥

After selecting your file type with a Jpeg, you will be asked to
select a quality.
Use low for most things (2-3), medium (4) for people's faces.

Photoshop
Photoshop 2.0
BMP

CompuServe GIF
Photoshop EPS
JPEG

PCX

Photoshop PDF
PICT File

PICT Resource
Pixar

PNG

Raw

Scitex CT

Targa

TIFF

Photoshop DCS 1.0
Photoshop DCS 2.0

To save as a GIF select Save for Web from the file menu. You can look at your
potential gifs optimized, 2-up, 4-up and original by selecting the corresponding tab on the
main window. In the 4-up window you can view your gifs with different pixel patterns

and quality with an approximate download time.
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